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1. Introduction

The CV Cinelerra Manual covers “The Secrets of Cinelerra” and can be found at:

https://cinelerra-cv.org/docs/cinelerra cv_manual en.html

This manual covers features or areas of Cinelerra that are different or new in the 5.1 version from the
standard CV Community version. Many of the new features were created by a lot of different people to
include the original author and were merged in from various sources and each person is to be
commended for their efforts. The content of this manual also came from various people/places/email
and thanks to all.

1.1 How to Build Cinelerra 5.1 from Developer's Git Repository

These are generic build instructions for building Cinelerra 5.1. Known to work on ubuntu, mint, suse,
fedora, debian, centos, arch, and 32-bit slackware. It has not been tested on every single possible distro
yet so you might expect to have to make some minor changes. It has failed miserably on FreeBSD. At
least once, a Gentoo version was successfully created.

Alternatively, there are some pre-built 5.1 dynamic or static binaries which are updated on a fairly
regular basis (as long as code changes have been made) available at link below. See Section 1.2.

https://cinelerra-cv.org/five

There are 2 kinds of builds, the default system-build and a single-user build. A system build has results
which are installed to the system. The majority of the files are installed in the standard system paths,
but some customization is possible. The single user build allows for running completely out of a local
user directory so it doesn't affect the system.

We recommend the single-user version when possible. It makes it very easy to install a new version
without having to delete the older version in case you want it for backup — once you are happy with the
new version, all you have to do is delete the entire old directory path. Also, if you install a new
Operating System version and if you have Cinelerra on separate disk space that is preserved, you won't
have to reinstall Cinelerra. In addition for purposes of having the ability to interrupt or to see any
possible error messages, if you start the application from a terminal window command line you will
have more control to catch problems. The system builds can be useful in a university lab setting where
there are possibly multiple users, or multiple versions.

There are two notable differences between “standard” views of Cinelerra and this implementation for
the system builds. Both of these can be configured during installation. These differences make it
possible to have several different versions installed without having them “walk” on each other.

1) application name can be set during installation and defaults to: “cin”
2) the home configuration directory can also be set and defaults to: “¢HOME/.bcast5”


https://cinelerra-cv.org/docs/cinelerra_cv_manual_en.html
http://cinelerra-cv.org/five/tars

To do a system build, you should read the README that is at the top level after you get the source.

1) You need at least 2.5GB of disk storage to operate a build. Need to have “git” installed.
2) Obviously in order to install into the system, you must run as root.

3) The "git" step has to download a bunch of stuff (approx 100MB) so allow time.

4) Run the following commands (this takes awhile):

cd /<build_path>/ # this is where you need the 2.5GB of disk space
git clone --depth 1 "git://git.cinelerra-cv.org/goodguy/cinelerra.git" cinelerra5
cd cinelerra5/cinelerra-5.1 # toplevel directory

NOTE: if your system has never had Cinelerra 5.1 installed, you will have to make sure you have all of
the compilers and libraries necessary. So on the very first build you should run:
./bld_scripts/bld_prepare.sh <os> # where <os> represents the Operating System of
centos, fedora, suse, leap, ubuntu, debian.
Jautogen.sh
.Jconfigure --prefix=/usr ~ # optional parameters can be added here
make 2>&1 | tee log # make and log the build

5) Check for obvious build errors:
grep "\¥\*\* *error" -ai log
If this reports build errors, email the log which is listed below to cinelerra@lists.cinelerra-cv.org :
/<build_path>/cinelerra5/cinelerra-5.1/log

6) If there are no build errors, finally just run:
make install
7) If it all worked, you are all setup. Just click on the “blue lady” cinelerra desktop icon.

To do a single-user build, read the README that is at the top level after you get the source.

1) You need at least 2.5GB of disk storage to operate a build. Need to have “git” installed.
2) Recommend you build and run as root, just to avoid permission issues initially.

3) The "git" step has to download a bunch of stuff (approx 100MB) so allow time.

4) Run the following commands (this takes awhile):

cd /<build_path>/ # this is where you need the 2.5GB of disk space
git clone --depth 1 "git://git.cinelerra-cv.org/goodguy/cinelerra.git" cinelerra5
cd cinelerra5/cinelerra-5.1
NOTE: if your system has never had Cinelerra 5.1 installed, you will have to make sure all of the
compilers and libraries necessary are installed. So on the very first build you should run as root:
./bld_scripts/bld_prepare.sh <os> # where <os> represents the Operating System of
centos, fedora, suse, leap, ubuntu, debian.
.Jautogen.sh
Jconfigure --with-single-user # the “with-single-user” parameter makes it so
make 2>&1 | tee log # make and log build (check for errors before proceeding)
make install

Then just start the application by keying in: ./cin in the bin subdirectory OR add a desktop icon by
using the appropriate directory to copy the files to, run as root, and edit to correct the directory path.


http://git.cinelerra-cv.org/goodguy/cinelerra.git
mailto:cinelerra@lists.cinelerra-cv.org
http://git.cinelerra-cv.org/goodguy/cinelerra.git

cd /cinelerra_directory_path
cp -a image/cin.{svg,xpm} /usr/share/pixmaps/.

cp -a image/cin.desktop /usr/share/applications/cin.desktop
change the “Exec=cin” line to be “Exec=<your_directory_path>/bin/cin”

The preceding directions for doing a single-user build has been meticulously followed to build and run
on a newly installed ubuntu 15 system WITHOUT BEING ROOT except for the bld_prepare.sh and
creating the desktop icon.

1.1.1 Notable Options and Caveats

These procedures and the 5.1 Cinelerra software have all been run as “root” on home laptops/desktops.
This provides the best chance to ensure all works correctly and also allows for handling errors, other
problems and potential crashes with the most success. Included in this section are some of the build
variations easily available for normal builds.

To see the full list of features use:  ./configure —help

The default build is a system build which uses: ./configure —without-single-user

In the single-user build, the target directory is always “cin”. Because this is also the developer build,
constant names are used throughout. However, you can rename files after the install is complete.

If your distro/operating system has issues with the default install to /usr/local, you might have to
change the location to /usr for a system build. Then you will have to use:
./configure --prefix=/usr

If you wish to change the default directory for a system build you will have to add the destination
directory path on the “make install” line. For example:
make install DESTDIR=<your selected target directory path>

The application name can be set during installation, but defaults to cin so that the 5.1 build can coexist
with other Cinelerra builds if necessary. To override the default cin name, use:
Jconfigure --with-exec-name=cinelerra

The home configuration directory can also be set, but defaults to $$SHOME/.bcast5. For example:
./configure —with-config-dir=/myusername/.bcast5

NOTE: when you specify parameters to the configure program, it will create a make file as a

consequence. Since in a make file, the $ is a special character, it must be escaped so in order to

represent a $ as part of an input parameter, it has to be stuttered. That is, you will need $$ (2 dollar

signs) to represent a single dollar sign.

It may be necessary on some distros which have missing or incomplete up-to-date libraries, to build
cinelerra without Ladspa. To do so, use:

./configure --prefix=/usr --without-ladspa-build

Note that the with-ladspa-dir is the ladspa search path, and exists even if the ladspa build is not
selected. This gives you the ability to specify an alternate ladspa system path by utilizing the



LADSPA_PATH environment variable (that is, the default ladspa build is deselected).

To build a 10-bit version for x264 and x265, it is a sad truth that the x264 and x265 libraries require
“special” builds to encode 10/12 bit output, and so a separate version of cinelerra is needed to create
these kinds of codec output. To build these:

./configure --with-exec-name=cinx --enable-x264_hidepth --enable-x265_hidepth

Unfortunately, these libraries can only be configured to encode either 8-bit or 10/12-bit but not both
compiled simultaneously. The 10-bit compiled Cinelerra can read 8-bit or 10-bit but can only render to
10-bit. Newer video equipment may take advantage of the 10-bit color depth for improved quality.

Note for 32-bit 14.2 Slackware, Debian, Gentoo, Arch, FreeBSD, before running the configure, you
will need to set up the following:

export ac_cv_header_xmmintrin_h=no
export FFMPEG_EXTRA_CFG=" --disable-vdpau"

1.1.2 Notes about Building from Git in your Customized Environment

Getting a build to work in a custom environment is not easy. If you have already installed libraries
which are normally in the thirdparty build, getting them to be recognized means you have to install the
"devel" version so the header files which match the library interfaces exist. Below is the list of
thirdparty builds, but this list may have changed over time:

a52dec yes
djbfft yes
fdk auto
ffmpeg yes
fftw auto
flac auto
giflib yes
ilmbase auto
lame auto

libavc1394  auto
libraw1394 auto
libiec61883 auto

libdv auto
libjpeg auto
openjpeg auto
libogg auto
libsndfile auto
libtheora auto
libuuid yes

libvorbis auto
mjpegtools  yes

openexr auto

tiff auto



twolame auto

x264 auto
X265 auto
libvpx auto

The "yes" means force build and “auto” means probe and use the system version if the build operation
is not static. To get your customized build to work, you need to change the probe options for the
conflicting libraries from "yes" to "auto", or even rework the configure.ac script. There may be several
libraries which need special treatment.

An example of a problem you might encounter with your customized installation is with “a52dec”
which has probes (CHECK_LIB/CHECK_HEADER in configure.ac), but djbfft does not. In this case,
djbfft is only built because a52dec is built, so if your system has a52dec, set a52dec to auto and see if
that problem is solved by retrying the build with:

.Jconfgure --with-single-user —enable-a52dec=auto .

With persistence, you can get results, but it may take several tries to stabilize the build. If you need
help, email the "log" and "config.log", which is usually sufficient to determine why a build failed.

1.2 Just Install It! Binaries Already Built

If you prefer to not have to take the time to build Cinelerra 5.1 yourself, alternatively there are some
pre-built 5.1 dynamic or static binaries for various versions of ubuntu, mint, suse, fedora, debian,
centos, and arch-linux. There are 32-bit i686 ubuntu and debian versions and a 32-bit slackware
version available also. These are updated on a fairly regular basis as long as significant code changes
have been made. They are in subdirectories of:

https://cinelerra-cv.org/five/tars
https://cinelerra-cv.org/five/pkgs

The “tars” directory contains single-user static builds for different distros. This is the recommended
usage of 5.1 because all of the files will exist in a single directory. To install the single user builds,
download the designated tarball from the ./tars subdirectory and unpack as indicated below:

cd /path

mkdir cin

cd cin

tar -xJf /src/path/cinelerra-5.1-*.txz  # for the *, substitute your distro tarball name

Do NOT download the LEAP 10bit version unless you use h264/h265 (they can't render 8bit h26x).

The “pkgs” directory contains the standard packaged application for various distros. This will install a
dynamic system version for users who prefer to have the binaries in the system area and for multi-user
systems. In addition, performing the package install checks the md5sum in the file md5sum.txt to
ensure the channel correctly transmits the package. There is a README.pkgs file in the “pkgs”
directory with instructions so you can “cut and paste” and avoid typos; it is also shown next.


http://cinelerra-cv.org/five/tars
http://cinelerra-cv.org/five/tars
http://configure.ac/
http://configure.ac/

README.pkgs:

Depending on the distro, use the instructions below and select the appropriate
setup operations to install, update or remove cinelerra 5.1.

To upgrade, refresh repo, then replace "install" with "update", or whatever.

# FEDORA
dnf install cinelerra --repofrompath cincv,https://cinelerra-cv.org/five/pkgs/fedora/
##dnf erase cinelerra

# CENTOS

# first create the file /etc/yum.repos.d/cincv.repo, with the following contents:
[cincv]

name=cincv

baseurl=https://cinelerra-cv.org/five/pkgs/centos

gpgcheck=0

# end of cincv

yum install cinelerra

##yum erase cinelerra

# UBUNTU/DEBIAN, replace ub17 with your distro id: ub14,ub16,debian,mint (see note below for
MINT/DEBIAN 32-bit)

# Some ubuntu apt downloads register status as working 0% constantly while running the package
# download, like ubuntu 14. It may take a few minutes for this step so be patient.

apt install software-properties-common apt-transport-https

apt-add-repository https://cinelerra-cv.org/five/pkgs/ub17

# Debian 8.8, you may need: apt-add-repository https://cinelerra-cv.org/five/pkgs/debian jessie main
apt update

apt install cin

#to update a previous install

apt update

apt upgrade cin

##apt remove cin

# MINT note: apt-add-repository did not work for me, I had to use the gui version:

# Administration->Software Sources->Additional Repositories->Add a new repository
# deb https://cinelerra-cv.org/five/pkgs/mint trusty main

#then: apt install cin (or apt remove cin)

#DEBIAN 32-bit note - This has been shown to work, but things change quickly:
apt install software-properties-common apt-transport-https

apt-add-repository https://cinelerra-cv.org/five/pkgs/debian

# VIP - for the first install, the above line adds cinelerra to /etc/apt/sources.list but...
# Debian "Stretch" is more strict for licensing so you will have to edit

# the file /etc/apt/sources.list to add [trusted=yes] after deb and before https...cin...
# For example the line should be: deb [trusted=yes] https://cinelerra-cv.org/five/pkgs/debian jessie
main

# UBUNTU 16 - This has been known to work, but things change quickly:

apt install software-properties-common apt-transport-https

apt-add-repository https://cinelerra-cv.org/five/pkgs/ub16


https://cinelerra-cv.org/five/pkgs/ub17
https://cinelerra-cv.org/five/pkgs/ub17

# VIP - for the first install, the above line adds cinelerra to /etc/apt/sources.list but...

# Version 16/17 of Ubuntu are more strict for licensing so you will have to edit

# the file /etc/apt/sources.list to add [trusted=yes] after deb and before https...cin...

# For example the line should be: deb [trusted=yes] https://cinelerra-cv.org/five/pkgs/ub16 xenial main
# Or for ub17: deb [trusted=yes] https://cinelerra-cv.org/five/pkgs/ub17 zesty main

# Also, on the install you will get an error message that you can either ignore as cinelerra

# will run anyway, or else (the first time only) on the commnand line keyin:

echo > /etc/sysctl.d/50-cin.conf "kernel.shmmax=0x7fffffff"

apt update

apt install cin

#to update a previous install (ignore any i386 errors as only 64 bit version available):
apt update

apt upgrade cin

##apt remove cin

# SUSE/LEAP, replace leap with your distro id: suse, leap

zypper ar -f https://cinelerra-cv.org/five/pkgs/leap/ cincv

zypper install -r cincv cinelerra

##zypper remove cinelerra

#to update a previous install (assuming you enabled autorefresh as above)
zypper refresh cinelerra

zypper up cinelerra # or cinelerralObit for 10 bit

# SLACKWARE, substitute slk32 for slk64 and i486-1 for x86_64-1

wget -P /tmp https://cinelerra-cv.org/five/pkgs/slk64/cin-{date } -slk64-x86_64-1_cin.txz
installpkg /tmp/cin...

#to update a previous install

upgradepkg /tmp/cin...

##removepkg cin

# ARCH linux

# first edit the file /etc/pacman.conf, to include the following:
[cincv]

SigLevel = Optional TrustAll

Server = https://cinelerra-cv.org/five/pkgs/arch

# end of cincv

pacman -Sy

pacman -S cin

##pacman -R cin

1.3 The SHOME/.bcast5 Directory

A difference in Cinelerra 5.1 is the name of the user's default settings and saved files directory. It is
called .bcast5 as opposed to .bcast as a subdirectory in SHOME. Initially when cinelerra is launched
there is an empty project and there are program default settings, and from then on the .bcast5 directory
will contain the settings that were created before the last closing. If you need to revert to the default
settings, delete the .bcast5 directory contents and restart Cinelerra. Or you may want to rename it
temporarily if you think you might want it back later.



2. FFMPEG Early Probe Explanation

When you open media, a series of libraries and codec functions are used to "probe" the data, to see if it
can guess the type of file format and codec parameters needed to correctly decode the file. If ffmpeg
probes early - “Try FFMpeg first” is in effect for the button - it will usually find some way to try to
decode just about any contemporary media file. But there are some times that the built in codecs are
actually a better choice. A lot of this may fall into the category of personal preference. For example,
some may prefer the mpeg library in the cinelerra code over the ffmpeg code because it has more
decoding capability and seems to be more robust when the media is damaged. In that case you will
want the FF button to read “Try FFMpeg last” in the upper right hand corner of the main window.

So, if ffmpeg probes early, you will never get to use the built in libraries, and if you want to skip over
buggy old libraries, use ffmpeg early probe enabled so that the newest code will be tried first.

When the icon is red, ffmpeg probes early is enabled and you will see it reads “Currently: Try FFMpeg
first” when moving over the FF button in the upper right hand corner of the screen. When the icon is
black, ffmpeg probes early is disabled so that ffmpeg probes late and it reads “Currently: Try FFMpeg
last”. The initial default state of the icon is on, that is, ffmpeg probes first. This is the original code
behavior before ffmpeg code was added. Suggestion is to leave it on except in a few special cases
where it may be better to have early probes disabled. When you mouse over the main menu ff toggle
button, the text displays ffmpeg's “Currently” set position and “Click to” change it.

The ffmpeg early probe state is saved between sessions and is also affected by choices made in Probe
Order (see section 40.14). It is important to note that the various file indexes may need to be rebuilt if
you change which codec is being used to decode the file. There is a warning popup to remind you
when you change the default ffmpeg early probe state (unless you have checked the box to no longer
show you the warning).

Screenshots below show (1) reddish colored FF in upper right hand corner of main screen indicating
that ffmpeg early probes is enabled; (2) “Try FFMpeg last” indicator message for ffmpeg early probes
enabled (note that the color is different because you highlighted the icon); and (3) black colored FF
indicates ffmpeg will be used last and you are changing the behavior so that Cinelerra warns you
accordingly.

Cinelerra: Warning

Changing the base codecs may require rebuilding indexes

™ Don't show this warning again



3. How to Create FFMPEG Options Files

This section describes how the FFMpeg options files work for decoding and encoding and goes into
great detail. It will make more sense if you look at cinelerra's ffmpeg config directory and the cinelerra
menus at the same time. It is meant to include everything necessary for complete understanding. You
will be able to personalize your own options files without knowing all of the information included
below if you know the basics. The word encoding is used interchangeably with the word rendering.

The possible combinations for ffmpeg options files are literally combinatorial — that is a lot (factorial!).
The allowed media file format / codec choices are much more flexible than you might realize. When
the ffmpeg design was initially added, some parameter files which describe the choices which the
program uses had to be created. There are way too many to enumerate in the deliverable Cinelerra
package. Some quite detailed information for how ffmpeg options work is given here and hopefully,
enough basics for simple understanding. It may all seem complicated at first, but will become obvious.

3.1 File naming convention

In Cinelerra's ffmpeg configuration directory you will see files as listed and described below. File type
and extension names are the key for Cinelerra's use of ffmpeg. Basically the .opts file extension
represents options; .dfl represents defaults; and all the rest are media types. For example one media
type is quicktime so that *.qt file names would be the “quicktime” choices. In the file names below,
“ext” refers to a set of files with file names matching the *.ext file extension. And “typ” refers to a
type of format / codec combination used, i.e, the media type.

In the ffmpeg configuration directory there are a series of options files used when encoding or decoding
audio or video. They are read in the order from top to bottom and only the files needed for the current
operation are added to the active configuration.

ffmpeg/ffmpeg.opts = global ffmpeg options, always used

ffmpeg/decode.opts = global decoder options, used when opening existing files for decoding
ffmpeg/encode.opts = global encoder options, used when creating new files for encoding
ffmpeg/audio/audio.opts = audio encoder options, used when creating audio streams
ffmpeg/video/video.opts = video encoder options, used when creating video streams
ffmpeg/plugin.opts = parameters for ffmpeg filters as audio/video plugins

Decoder options:

Normally, only ffmpeg.opts and decode.opts are used when reading/decoding files, but may be
specialized if a <path>/media.opts exists for a given <path>/media.ext file. For example, if you want
to only fail on fatal errors and to always use the video filter, edgedetect, when working with your media
file “dreaming.y4m”, then create a file “dreaming.opts” in the same directory with the contents of
“loglevel=fatal” on the first line and “video_filter=edgedetect” on the next. These specialized settings
will override the defaults. The fatal loglevel is especially handy for lesser quality media.

Encoder Options:

Within the audio /video subdirectories of the first level ffmpeg directory, the typ.ext files are for



encoder (rendering) setups.

ffmpeg/audio = directory of audio encoder settings

audio.opts = options used by all audio encoders

typl.ext, typ2.ext, ... = are all *.ext type choices for encoding audio

ext.dfl = contains the default selection used when ext is first selected
ffmpeg/video = directory of video encoder settings

video.opts = options used by all video encoders

typl.ext, typ2.ext, ... = are all *.ext type choices for encoding video

ext.dfl = contains the default selection used when ext is first selected
ffmpeg/format = presets needed to initialize audio / video formats

3.2 Option File Format / Content

For the option files a specific format must be followed in creating the file content.
In typ.ext encoder parameter files, the first line is defined as:

muxer codec
or  muxer codec | bitstream filter [ bitstream filter options ]

where the | represents piping the codec data through the bitstream filter.
The rest of the lines in the file should look as follows:

# in column one is a comment

id1 wvaluel

or id2 = value2

Only one equals sign is allowed and it is just for readability. There may be any number of id / value
pair lines in a media definition, including zero. A typical line might be:

bitrate 4000000
or bitrate = 5000000

There are 4 special id's recognized by cinelerra which cause special processing. They are:
duration (overrides the probe duration when opening media for decoding)
video_filter (adds an video stream filter, eg. edge detect, ... at the stream level)
audio_filter (adds an audio stream filter, eg. echo, ... at the stream level)

loglevel (sets the library logging level, as quiet, panic, ... verbose, debug)

All other id's should be in the ffmpeg documentation, and correspond to the global, muxer, and codec
option names and values used by ffmpeg. For example to set the aspect ratio to 4:3, use:

aspect 4:3



Below shows an example: "decode.opts" which is used when the ffmpeg decoder is initialized.
# apply at init decode
loglevel=fatal
formatprobesize=5000000
scan_all_pmts=1
threads=auto

The encoder options you see in the cinelerra menus depend on the files in these directories, NOT THE
CODE. If you add files, you will get to use more variety.

In the "cinelerra" directory, which contains the ffmpeg configuration folder, there are the choices the
program uses. When you open an ffmpeg format popup dialog, the listbox contains all of the codec
types which are identified by the file.ext extensions. Decoding has only a few options, since the
ffmpeg file probes determine most of the options by looking at the media being opened, but encoding
media requires a lot of setup. Below are some of the folders and files used to determine the
configurations used by ffmpeg to decode and encode files.
These extensions create audio / video media classes:
dvd m2ts mkv mp3 mp4 mpeg qt pro
which become the choices in the render pulldown menu
So if you want to create a "mov" codec class, add two new files to the ffmpeg configuration directory:
audio/aud.mov and video/vid.mov
Now you will see this as what you can choose in the rendering choices for ffmpeg.
Inside the file you will see that the first line is special. It is the muxer and codec. For example:
h264 libx265
The contents may be something like: <path>/video/vid.mov =
mp4 1ibx265
bitrate 4000000
This will code an mp4 formatted file using the 1ib264 codec encoder.
For audio and video together, the mux format must agree between the aud.mov and vid.mov files
when they are to be used together. The stream muxer must be the same for the all the streams in the file

being written.

for example: <path>/audio/aud.mov =
mp4 pcm_mulaw

This will create mp4 media using audio format pcm_mulaw coding.



Both the audio and the video are using mp4 mux format, and so there will be 2 streams:

1) x265 video
2) pcm_mulaw audio

When the menu popup is created, there may be many choices for that class type, so you may want
defaults. That can be specified as:

audio/<class>.dfl and video/<class>.dfl

So: audio/mov.dft =
aud.mov

and: video/mov.dft =
vid.mov

The above will be the default choice when the menu opens.

When you see problems in using the new options files you have created and put into place, add the
following line to ffmpeg/encoder.opts:

loglevel=verbose
sometimes that will be enough to see what has caused a failure, or even catch unexpected results.

Now there is an EXCEPTION to all of the above because of a conflict between ffmpeg and the x264
person making the detect ion of default ffmpeg settings terminate with an error. If you get this error,
you must workaround this termination by including parameters that don't match 5 or more of the
normal expected values. So you just have to change a few parameters to avoid the probe detection.
Here is an example where you will notice the x264opts line tweaking values to throw off the
detection/error termination code.

<path>/ffmpegvideo/test.mp4 =
mp4 libx264
preset=slow
x2640pts keyint=25:min-keyint=4:qpmin=3:qpmax=33:qp_step=4:merange=8
crf 20

Another EXCEPTION is for some forms of aac, which is the reason had to add bitstream filters.
If you think that you are in this situation, use:

<path>/ffmpeg/audio/test.mp4 =
mp4 libfdk_aac

For more examples, look around the ffmpeg dir for examples which may be close to what you are
trying to use, and see if the parameters look usable.

This is quite complicated, but that is because ffmpeg has a lot of parameters and history. Good results
are not that hard to create. Initially you should mostly use the defaults. If you send any new options
files to cinelerra@lists.cinelerra-cv.org , it may be given consideration to being added to the baseline
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for the possibility for future deliverables.

To get a listing of the current ffmpeg supported formats and codecs that can be made to work with
cinelerra, provided there are option files added, run the following commands. This should be done
from the <build>directory substituting the location of <build> where you have installed cinelerra on
your system and the ffmpeg may be a later version than 3.1.2 as used below. Then look at the output
created in /tmp/ff-formats.txt and codecs.txt.

/<build>/cinelerra-5.1/thirdparty/ffmpeg-3.1.2/ffmpeg -formats > /tmp/ff-formats.txt
/<build>/cinelerra-5.1/thirdparty/ffmpeg-3.1.2/ffmpeg -codecs > /tmp/ff-codecs.txt

3.3 Complete Options File Example

For illustrative purposes, here is an example of the options files that need to be added for using the
ffmpeg ProRes 422 format. This makes it possible to transcode to h264.mov with FFmpeg retaining 10-
bit yuv422p from the source to the target output video.

Add the file named “./ffmpeg/audio/acc256k.pro” which contains the following lines:
mov libfdk_aac
strict -2
b 256000

(Note that in the example above, even though the bitrate is set here to 256000, it can be
overridden by the render menu settings).

Add the file named “./ffmpeg/audio/pro.dfl” which contains the following lines:
acc256k.pro

Add the file named “./ffmpeg/video/med422p10.pro” which contains the following lines:
MoV prores
preset medium
pix_fmt yuv422p10le

Add the file named “./ffmpeg/video/pro.dfl” which contains the following lines:
med422p10.pro

Then to use and to get 10 bit depth and preserve depth from decode to encode:

1) load media

2) use settings->format to set the frame rate, sample rate/channels, aspect ratio,
color model = rgb_float or rgba_float if blending

3) press Shift-R and select FFMpeg format type “pro”

4) select target path

5) check ok, and watch for messages in the terminal window



3.4 The FFMPEG Image2 Streams

Another feature gained from using ffmpeg in cinelerra takes advantage of what is being referred to as
the “%d trick”. This trick uses the ffmpeg muxer image2 and a filename template to create a series of
image files of a given kind. A specific example is described below.

To encode a series of 48 bit tiff output image files, add a file to the cinelerra data ffmpeg/video
subdirectory as in:

filename: .../ffmpeg/video/tiff.dfl containing the line:
tiff48.tif

Then create an ffmpeg video encoder parameters file in the same directory:

filename: .../ffmpeg/video/tiff48.tiff containing the next 2 lines:
image? tiff
pixel_format=rgb48

This will define a new ffmpeg encoder format which is a video image file format that uses the tiff
codec for encoding, and a pixel_format of rgb48 (or a similar equivalent such as rgb48le). Next load
up your project and set up for a Render using File — Render in the usual way. Now the tricky part; the
output file name should contain a %d which will be the frame number used in the image output
filename as in: Select a file to render to = /tmp/tiff_images/img%03d.tiff. You will get multiple files as
output — one for each frame!

The resulting directory of images can be opened for reading by simply opening the template path. As
in: File —» Load Files = /tmp/tiff_images/img%03d.tiff. You will notice a file named as same as the
template, which has been automatically created, is empty,is needed, and has to remain with the set.

3.5 Ffmpeg Common H.264 Rendering

Because H.264 is so widely used, the method in 5.1 Cinelerra is outlined below. These setup steps
make it easy to just get started.

File->Render

File Format->FFMPEG + mp4

Video Wrench->Preset->h264.mp4 + bitrate: 6000000 (or whatever) +OK
Audio Wrench->Preset->h265.mp4 + bitrate: 224000 (or whatever) + OK
Set your target path in: Render=>Select a file to render to

Set your timeline in: Render=>Render range + click Project

Set your insertion strategy: Replace project (or whatever)

Press OK to start rendering.



4. Viewing & Modifying Ffmpeg Format Options inside Cinelerra

There are thousands of options for using ffmpeg. Now it is possible to “view” the available options for
a particular video and audio choice by using the “wrench icon” and then clicking on the “view” box.
Ffmpeg has to be the selected file format for this feature to be visible. It makes it a lot easier since only
the applicable options show up as opposed to everything that ffmpeg can do. These options are just
“Hints” and some may be missing due to the way that ffmpeg options are coded — Cinelerra shows the
option data ffmpeg has exposed.

As an example, instead of reading the entire 264 library information, you only have to look at the
shown available options. Both the video and the audio are browsable. The options visible in the
Audio/Video Preset textbox are the final values which are used when rendering once you have checked
OK. For assistance in choosing the options you want, use the view popup to see the objects that go
with the selected format tool, highlight the option, modify the parameter value in the box at the top of
the “Options” window based on what you want, and then click apply. Updates modify parameter
values or new parameters will be appended at the bottom. Note that when you highlight an option a
tooltip will show up when available in the lower right hand corner which describes the option. Also
note that the Format and Codec types are shown on the top line of the Options window.

Parameters exist in 3 layers: ffmpeg, codec, and an interface layer. You can apply parameters to each
layer. The top 2 layers are accessed with the Kind popup menu. The ffmpeg layer is topmost, and is
selected as Kind: ffmpeg. It can specify many of the more common parameters, such as the bitrate,
quality, and so on. The middle layer is selected as Kind: codec. These options can specialize your
choices, and frequently includes presets and profiles useful for coding well known parameter sets, like
profile=high422, preset=medium, or tune=film, etc. The interface layer may or may not be available.
It is usually accessible only by an “opts” parameter, like x264opts=key=value:key=value:... These
options are passed directly to the low level codec library.

The 2 screenshots next show “ffmpeg” for as the Kind: for Video first and then “codec” Audio second.
Note the x264opts in the Video Preset window immediately below.

Cinelerra: Batch Render

Cinelerra: Options

ceyint=4:gpm




Note the yellow tooltip in the lower right hand corner describing the highlighted option. Also note the
allowed “Range” values above the box provided for keyins.

Cinelerra: Batch Render

Output path:

Preerre tereo Down Mode

5. FFMPEG Items of Note

Quality Option when rendering: Ffmpeg responds variably to the quality option in the render option
but seems to respond well to bitrate. The subranges used by quality even seem to vary somewhat
depending on how old the codec is. Some use 0 to 35, some use 0 to 500 or so. The quality is supposed
to cause the codec to output data until the noise level is below a limit determined by the quality setting.
Your specific results may vary.

Previous Changes when rendering: With ffmpeg there are 2 cases that the defaults will be used. The
first time when you have nothing set up and any other time when you reset the render File Format in
the Render Menu. Otherwise with ffmpeg if you change a video compression type for the render (for
example h265.mp4 to h265.mp4), the settings will be from the previous session settings.

Outstanding Issues with ffmpeg: There are some problems that need to be addressed by the ffmpeg
developer group that adversely affect Cinelerra. These are stated below with the hopes that that group
will fix them as time permits.

1) Make all the default parameters operational. When they are not, the Cinelerra plugins can't
be initialized since the initial state of the filter is not operational. If that is not possible, then
provide a set of nominal parameters for each plugin, so that they can be used as the plugins
initial default state.

2) Make the filter config function project the new parameter data into the filter function at any



point during filter operation. This is so that continuous updates can be done as the plugin
operates.

3) Improve seek codec restarts. The past predictor must be reset or reconstructed after a seek.
The only documented way to seek is open/seek/play. Reopening the format layer is very
expensive.

6. Problem Resolution Help

You can report potential problems, bugs, and crashes to the Cinelerra-CV website via email address:
cinelerra@lists.cinelerra-cv.org . At a minimum, instead of starting cinelerra from the icon, run from a
terminal window so that if there are error messages related to the problem, they can be captured on the
screen and passed along. The command to run from a terminal window is: <directory_path of where
you installed cinelerra>/bin/cin — for example if installed at directory /mnt0/build5/cinelerra-5.1, you
would execute the following command to start the program /mnt0/build5/cinelerra-5.1/bin/cin.

6.1 What to Include in Problem Reports

For the best help, if you have a reproducible problem the following list of descriptive items makes it
possible to figure out what the problem is and how to fix it. It may be a usage/setup mistake or a real
bug which a programmer might like to fix rather quickly. Although it is not always necessary to
provide this much information, it eliminates the “try this” or “did you do this?” and a lot of “guessing”
rather than heading straight for a solution.

Basically we need to see what you see with the input, output, and session file:

1) need a detailed description of the problem;

2) supply a small representative sample of the original input that exhibits the issue;

3) if possible, also provide the rendered output, again using that representative sample;

4) save a session file used with that same sample which will contain a lot of setup parameters;

5) to make sure that the same rendering setup is used, it may be necessary to send an additional
session file at the definition point just before rendering starts.

It is better to upload any files to a datahostfile site as sometimes they can be larger than the CV mailing
list would like.

How to create a session file: from the menubar pulldown File — Save_as... and choose a filename,
for example /tmp/beforerender.xml . Do this after you have the situation setup so can see values in use.

How to create a representative small sample:

- open the input media, setup as you normally would to start the project render;

- select 5-15 seconds of media using the edit mode ptrl button drag highlighting on the timeline;
- start the render dialog (Shift R), set the filename path, and set “Render range” to “Selection”;

- recommended “Insertion strategy” is “Replace current project”; then press the checkmark OK.

(The result will “load replace” the current project for review.)
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6.2 Crash Dumps for Analysis

If you get a SEGV signal crash and can explain what steps you took, a /tmp/cinelerra_<pid>.dmp file is
very useful for analysis. You can also use Ctrl-C in the controlling terminal window to force an INTR
signal interrupt when you think the program is hung up. It is best to upload the .dmp, input files and
other files to datafilehost or similar temporary site as they may be quite large. The .dmp filename looks
like /tmp/cinelerra_<pid>.dmp. Email all helpful information on the crash, location of uploaded files,
and list of setup steps that illustrate the problem to cinelerra@lists.cinelerra-cv.org .

1) Use the latest version of Cinelerra as you want to make sure problem hasn't been fixed.

2) Be sure gdb is installed (usually installed but if not, easily downloaded/installed by anyone)
3) Run as root (this enables using gdb to create a /tmp/cinelerra*.dmp).

4) Be sure Settings->Preferences->Interface->trap SEGV/INTR are checked.

5) Invoke the error. This should create /tmp/cinelerra-<pid>.dmp .

7. Speed / Fade Automation Usage and Auto Gang

Speed automation resamples the data at a higher or lower playback rate. Speed automation can operate
on all tracks of the same type, either audio or video, with a single click; or all tracks, both audio and
video, with a double click. The curves to be affected must be both armed and ganged in the track
patchbays to be included in the operation. You can see the advantage of having different media types
ganged the same so that they will remain synchronized. The double click feature also works in the same
manner for Fade Automation.

Steps to demonstrate Auto Gang of Speed on all of the audio AND video tracks are listed below:

1) Use the pulldown menu “View” on the main canvas and ensure that there is a checkmark left
of the Speed selection.

2) Double click and hold button 1 on any point of the Speed line on any track of the main track
canvas and drag the handle where you want it.

3) Note how all video and audio boxes move together simultaneously for synchronization.

Clicking on a speed keyframe handle will restart the drag operation on tracks of the same type. Double
clicking will select all tracks which have handles in the exact same cursor position.

8. How to Create Blu-ray and Standard DVDs

This section describes how to create a blu-ray DVD, or BD referring to a Blu-ray DVD, and a regular
DVD, or SD referring to a Standard DVD. The DVDs (plural usage of DVD means either BD or SD)
created are unencrypted, unlike commercially available movie DVDs. This Cinelerra version
conceivably can create different variations of DVD/Blu-ray media but for the casual user the most
standard usages are readily usable and will be described here.

Some preliminary information follows. For NTSC, SD media is almost always 720x480 interlaced (the
format in the United States, US). For PAL, SD media is almost always 720x576 interlaced (Europe,
EU, and most of the world). An SD can conceivably be created with a lower resolution — for example
352x240 MPEG-1 — but it is not useful. Aspect ratio for either NTSC or PAL can be 4:3 or 16:9.
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Frames per seconds is usually 29.97 for NTSC and 25 fps for PAL. The standard SD dvd generally
uses the MPEG-2 program stream with a filename extension of m2v. BD blu-ray media is not normally
interlaced, but you can leave it interlaced. Blu-ray uses the MPEG transport stream which contains 1
or more program streams with a default filename extension of m2ts.

Requirements for creating DVDs is the hardware device to write the media on and, obviously, the blank
media for either BD or SD. When generating SD media, you will have to install dvdauthor and for BD
media, install udftools if they are not on your system. Also, keep in mind that to mount filesystems
for creating files and to burn DVDs, you will have to be root since you have to have privileges,
unless special permissions have been provided for a non-root user. It is also highly recommended to
run the cinelerra startup from a terminal window, instead of the icon, in order to see informative
messages of how to actually write the output (at prompt: keyin <install_directory_path/bin/cin).

A warning here — writing blu-ray BDs and regular SDs can take a large amount of clock time. Keep in
mind that a blu-ray can contain 25 hours of viewing, so would take multiple hours to just write one.

The max disk space needed is a little over 100GB for 50GB Double Layer (DL) media or 50GB for a
single layer BD blu-ray. A standard SD of 4.7GB needs about 10GB disk space. You probably can get
by with much less if the render for blu-ray is less than 25 hours of media. You will need twice as much
disk space as the media holds to ensure you have sufficient space for working and copying.

The most important thing you need to know about in order to get started is "Format" and "Scale" in the
"Create dvd or bd" window. Format settings shown in the Set Format window are set accordingly to an
algorithm. Basically, it will take whatever you say in the asset format. It matches that against the
known Presets available so that is what will be shown. If the asset format doesn't match any of the
Presets default formats, then that will be shown as the "User Defined" format. In addition when you
load media, the format is initially set to “same as source” so matches the source input and if that
matches a known preset, then that is what is shown. The PAL versus NTSC only comes into play when
there is no known correct matching format when you attempt to create a DVD Render batch job. It is
applied when you click OK. For example, if you load up a YouTube video, it will not match any known
format and will choose PAL or NTSC based on time zone. [ =
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A quick set of basic steps to create DVDs is immediately below and usually just using the defaults
will get you something. However there is a serious issue with interaction between the Operating
System and bdwrite when creating a BD/blu-ray that requires automount to be turned off. Refer to the
details and more specific explanations below the following steps for how to do this.
0) If not logged in as root, you will get an error message in order to avoid doing a lot of work
and then failing out because root is required for automount and to write on DVD hardware.
1) Load your input source media via: File — Load files .
2) Choose PAL or NTSC for SD/dvd or 1080P/24 for blu-ray in Settings — Format .
3) For blu-ray, choose BD Render or for PAL/NTSC, choose DVD Render in File— .
4) Designate a “work path” with sufficient disk space and then Chk-OK .
5) When the Batch Render window comes up, click on Start and the batch jobs will run.
6) Read the final messages echoed to the screen to see the command for burning... OR
7) Use the provided directory name to: cd /<target directory>bd_(or dvd_)<date-time> .
8) Load your media, format if needed, note device name to substitute for <bd> or <dvd>.
9) If rewritable blu-ray, use dd if=./bd.udfs of=/dev/<bd> bs=2048000
If write-once blu-ray, use growisofs -dvd-compat -Z /dev/<bd>=./bd.udfs
If any DVD media, use growisofs -dvd-compat -Z /dev/<dvd> -dvd-video ./iso
Any problems encountered will require that you read more information in this section to include
specific details, helpful hints, and problem resolution.

Details and specific explanations to create blu-ray or regular DVD are provided here. It is very
advantageous to startup cinelerra from the command line prompt instead of the icon. Also, please be
root or your hard work will be lost when the automount is issued and fails for bluray udfs mounting.

The general design of the DVD/blu-ray generation operations is to first render media using batch
rendering and then terminate Cinelerra to start a script which creates the target device filesystem data.
These scripts are the dvd.sh and bd.sh scripts written into the target directory. For DVD, the general
plan is to write a directory <target>/iso with the dvd filesystem via dvdauthor and then generate an
is09660 filesystem and write it to a dvd via growisofs.

For blu-ray, the filesystem generation is slightly harder. First, it creates an empty filesystem image
<target>/bd.udfs using mkudffs which makes a big hole for the filesystem data. The hole is made just a
little bigger than the data written by bdwrite so that you don't have to write an entire 25GB or 50GB
disc even if no data exists. This empty filesystem is loopback mounted to make it writable, and the
linux kernel manages the filesystem image. The bdwrite program applies the blu-ray structure to the
UDF filesystem by creating the needed BDMYV blu-ray filesystem, which the kernel stores onto the
image file bd.udfs. When udfs is unmounted, the kernel finalizes the disk image on bd.udfs. The
bd.udfs image can be written directly to a blu-ray disk via dd or growisofs.

NOTE of IMPORTANCE: there is a serious situation with the interaction between the Operating
System (OS) and bdwrite when creating blu-ray, that requires automount to be turned off. The blu-ray
automatic script unmounts the blu-ray/UDF filesystem but the system has not finalized the directories
so the OS creates a new loop file device and the data is loaded and cached for use by the new loop but
it is stale. Consequences is that not all of the data is written where it should be. The solution is for the
OS not to mount this second mount so we have to make sure it doesn't. There are 2 methods to fix this.
The first and easiest is by using the following command to disable automount:

gsettings set org.gnome.desktop.media-handling automount false
This can be reversed when you have completed the blu-ray generation via:

gsettings set org.gnome.desktop.media-handling automount true



A different and more complicated method you can use to turn off automount is to download and install
the dconf-editor. Automount is a system parameter and only needs to be done once unless you do not
want automounts to always be disabled.

1) run: dconf-editor

2) select: org — gnome — desktop — applications->media-handling

3) uncheck: automount

4) close dconf-editor window

Immediately below are the detailed steps with explanations for creating SD or BD media.

1) Construct a session with the desired presentation:
Format frame rates choices are 29.97 or 25 for SD, based on the user's timezone, with NTSC
29.97/US or PAL 25 /EU. For BD, the media input will be analyzed to automatically pick the
default format or if unknown, the user's timezone will be used to default to 1920/29.97i for US
or 1920/25i for EU. Be sure to set the rendering parameters in the settings -> format menu.
Choose audio stereo or 5.1, again depending on your media.
Target Geometry will be 720x480 (US) or 720x576 (EU) for SD.

2) From the main window, select file—~BD Render or select file—DVD Render. Then:

In the “Title” textbox there will automatically be a unique name based on the current day and
time but you can change that to anything you want that is NOT already created.

Choose a “Work path” Target Directory in the work path textbox. Another big warning here is
to use a path that is NOT /tmp because a lot of linux distros wipe out /tmp on a regular basis
via cron, crash, or reboot. Furthermore, they tend to use ram based filesystems, which will be
way too small. You will lose your hard work so use disk space that is permanent. An icon in
the form of a magnifying glass is next to the work path which shows you file names/paths.

Disk space message will be green if you have at least 100GB/BD or 10GB/SD available

space (the disk space message will be red to warn you if you have less than these amounts).

Screenshot showing sufficient available disk space in green for blu-ray creation is below.
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Screenshot showing insufficient available disk space in red letters for SD dvd creation is below.
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(Continuation of Step 2)
Select desired features, check / un-check as appropriate.
Click OK check button. It is very important to realize that when you check OK, the EDL will
be saved and that will be used for batch job rendering. If you bring up the Batch Render and
then change some parameters, they will not take effect UNLESS you remember to either check
“Save to EDL Path” or “Use Current EDL” in the Batch Render window. You will get a
reminder automatically if “warn if jobs/session mismatched” is checked.

Explanation of the choice boxes as seen in the previous 2 screenshots for both SD and BD menus is
given below. Many of them are plugins which allow you to further manipulate the settings for best
results. They are just suggestions set by the program automatically based on your input media, and can
be reset to suit your needs. These are listed in the next 4 points.

1) If the media does not match the DVD target geometry, and the scale plugin is not already in
use, then the scale plugin is applied with scaling set to fit the media dimensions to the DVD
format target geometry.

2) If the video height is at least twice the DVD height and the input media is interlaced, then the
deinterlace plugin is applied with odd line sampling.

3) Audio 5.1 will automatically be set to the wide-audio if you have 6 tracks of audio.

4) To allow video data to be accessible and overlay properly, the track buffers are “resized” to

the largest track frame size in use (Resize Tracks). The theory behind this is to make sure to
have enough memory to cover the entire presentation for transcoding.

All of the current choice boxes are further defined immediately following.

Deinterlace — remove the interlace. Interlacing is a video scanning system in which alternating lines
are transmitted so that half a picture is displayed each time the scanning beam moves down the screen.



You lose a lot and the quality is bad when you view interlacing on a progressive TV. You might not
really want to use deinterlace, because if you deinterlace non-interlaced media, it will look awful.

Scale — alter the spatial mapping of an image to increase or reduce the size; modifies the picture. When
some programs scale from 4:3 to 16:9 they will automatically cut off the appropriate section of the
image for you. It is necessary to keep in mind, that square pixels is the true end goal of scaling, not the
aspect ratio which could result in squished or stretched output. More information about scaling will be
provided on a subsequent page with usage of the “Scale Ratio” plugin.

Histogram — remaps the color space. The color space ranges from 0-255 for 8-bit color values. You
can use this tool to remap the color space to use the entire space or for stretching the contrast. Also, it
lets you perform global color-correction on the image. You can use this to correct for color screens that
are 'too blue', or for color Televisions that produce 'brownish’ output, or whatever. In addition to color-
correction, you can use the RGB modification tool to add color to images that didn't have color to begin
with. For instance, you can “pseudo-color” greyscale media.

Inverse Telecine - the reverse of 3:2 pulldown where frames, which were duplicated to create 60-
fields/second video from 24-frames/second film, are removed. MPEG-2 video encoders usually apply
an inverse Telecine process to convert 60-fields/second video into 24-frames/second encoded video.
The encoder adds information enabling the decoder to recreate the 60-fields/second display rate.
Telecine, i.e. 3:2 pulldown, is used to transfer film to video. That's where the 3:2 ratio comes in. To
ensure that there will consistently be 60 frames per second, the first frame is displayed on the TV
screen 3 times and the second frame is displayed 2 times. The following frame is repeated 3 times, the
next one 2 times, etc. throughout the film. For inverse telecine, you show 2 of the film frames for 3 of
output frames. Only check “Inverse Telecine” if you have film or something that is 24fps and want to
project to 30fps (most likely this will never be necessary).

Audio 5.1 — 6 channel surround sound. For most home systems, uses five full bandwidth channels and
one low-frequency effects channel. Could automatically get set as explained previously.

Aspect Ratio — aspect ratio may be automatically set to 4:3 or 16:9. Aspect ratio would better be
defined as the size of the display, monitor, or TV which will be used to view the output. If you measure
your old TV, which supposedly is 4:3 and your latest digital TV, which is supposedly 16:9, you will see
that those ratios aren't always correct anyway. Then measure your laptop monitor, your desktop
monitor, and your neighbor's, and lo and behold, the ratios don't fit either of the purported “standard”
aspect ratio. Maintaining square pixels via scaling is more important in the long run.

Use FFMPEG - this is user's choice; it is recommended and faster but more difficult to modify due to
numerous options. For blu-ray, ffmpeg must be used and is not an available option.

Resize Tracks — change track width and height as explained previously. The size is adjusted to the
largest frame size needed.

Chapters at Labels — without this checked, chapters markers are automatically inserted every 5
minutes. The chapter labels can then be “skipped to” when playing the DVD. If instead, you want to
put labels in at opportune times, you will have to run dvdauthor outside of Cinelerra and mark the
chapter labels yourself by hand. In that case, you should checkbox “Chapters at Labels” so that the
automatic 10-minute labels are not created. This checkbox is not currently available for blu-ray.



The screenshot below shows on the upper right side the “Create DVD” window with Deinterlace,
Histogram and Resize Tracks checked. Also Scale is set to “Scaled”. Once the green checkmark is
clicked, the “Batch Render” window comes up and in the main window you will see the 3 plugins
below the video track on the main window. By clicking on the magnifying glass that appears on the
rightmost side, the controls for each will popup and you can make any necessary adjustments. Note the
numerous choices for Deinterlace; the Value, Red, Green, and Blue for color adjustments in the
Histogram window; and Scale Ratio popup menu for numerical settings control.

Cinelerra: Batch Render - o x Cinelerra: Create DVD =i o X

Media:

Britney Spears -

=

e

@ O ¢ v
& 4 4 O

" |Deinterlace

The Scale parameter gives you a lot of flexibility. A default based on your input media is provided for
you but possible choices are None, Scaled, Cropped, Filled, Horiz Edge, and Vert Edge. You will have
the opportunity to manipulate the desired results in the “Scale Ratio” window. Values for W (width), H
(height), and X/Y coordinates are the number of pixels. For example, if video is 720 x 432, that is
obviously 720 pixels by 432 pixels and this would be the values for Dst W and for Dst H. So if you
have some media that is off center you can crop by changing the SRC Y value AND then change DST
X/Y to non-zero. It will become the output origin. To see what it does, change them from 0.0 to 400.0
and you will see big changes in the compositor window.

For example, if you have the Cropped choice for the Scale, you will want to manipulate the ScaleRatio
plugin (the magnifying glass on the main window video track) which brings up the Scale window. For
cropped top instead of crop both top and bottom, modify the "Src Y". As you change the Y scale, you
will see the cropping take place in the Compositor.

Scaling options are provided in order to preserve image aspect ratio. To determine which scaling
option to use, it is important to correctly identify your source/destination video aspect ratios. Ne